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Foreword 

IPB University and CIFOR held training sessions entitled “The 
1st Training Series of TRADE Hub Indonesia on Social Network 
Analysis and Qualitative Analysis” on 7 and 14 November 
2020. This TRADE Hub Indonesia training was part of a series 
aimed at supporting TRADE Hub efforts to increase the 
relevance of, and promote the application of research, and 
help policymakers at all levels to develop and apply relevant 
policies and regulations more effectively. Target participants 
in the training series were not only TRADE Hub researchers in 
Indonesia, but also young researchers from universities and 
other institutions. The TRADE Hub Indonesia Training Series 
was expected to become a learning platform for stakeholders 
in Indonesia (policymakers, financial institutions and the 
private sector), and for students, academics, young 
researchers and practitioners with knowledge and skills to 
create robust research products, improve decision-making 
processes, and formulate and implement effective science-
based policies. 

The first training series focused on research methodologies 
and techniques based on the realization that researchers have 
important knowledge and skills to create robust research 
products in the topic of sustainable development, which is 
always complex, and had become even more so in the midst 
of the pandemic. Material from the training has now been 
compiled into book form to improve accessibility to this 
knowledge product.  

 

The authors 
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1. Preparing and installing NVivo (trial version) 

NVivo1 is a computer-based software package developed by Lumivero (formerly QSR 
International). It is a qualitative data analysis package, commonly used by academics 
worldwide, that helps researchers to prepare, analyse and find important points in 
non-numerical and unstructured qualitative data such as interview results, the 
outcomes of surveys with open-ended questions, journal articles, and social media 
and website content. The software is available through an annual or lifetime license 
and must be installed before use. NVivo offers a free license to install for a 14-day 
trial period without the need to register any payment information. An email address 
can only be used for registration for a one-time trial period.  

Minimum system requirements for installing NVivo on your computer are as follows: 

Minimum system requirements Recommended system requirements 

• 2.0 GHz dual-core processor (64-bit) 

• 4 GB of RAM 

• 1680 x 1050 screen resolution 

• Microsoft Windows 8.1 

• A minimum of 5 GB of storage space 
on your hard disk 

• 3.0 GHz quad-core processor  

• 8 GB of RAM or more 

• 1920 x 1080 screen resolution or higher 

• Microsoft Windows 8.1 or a more recent 
version 

• A minimum of 8 GB of storage space on your 
hard disk 

• An internet connection 

• Internet Explorer 11, Google Chrome 44 or later 

 

The steps involved in installing the trial version of NVivo on your computer are 
detailed below. And internet connection and time are required to download and 
install NVivo on your computer. The three steps shown below are explained in detail 
in the following pages. 

 

 

 
 

1  https://lumivero.com/products/nvivo/  

Create a myNVivo 
account

Download the 
software to your 

computer

Activate your trial 
license



 

 

2 

1. Open the link below 
through your web browser 
and select “FREE TRIAL”. 
Scroll down to NVivo and 
select “GET STARTED”. 

https://lumivero.com/resources/free-trial/  

 

2. First, to create an NVivo 
account you will be asked 
to fill in the required 
information. On 
completion you will be 
asked to log in to the 
Lumivero Dashboard. You 
will be directed to create 
an NVivo account first 
and complete the 
requested information. 
Once successful, you will 
be asked to log in again 
to the Lumivero 
Dashboard. 

 

 

3. After entering the 
Dashboard, “click 
Download NVivo for 
Windows”, or “Other 
version” for MacOS users. 

 

 

https://lumivero.com/resources/free-trial/
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4. Once downloaded successfully, the 
installer will be located at the bottom 
of your browser or in the downloads 
folder on your computer. Click “Open 
file” to open the installer. 

 

5. Click “Yes“ (This dialogue box does not 
always appear, but is likely to do so if 
you are using Windows). Select the 
language for the installation process, 
then click “OK“. Another dialogue box 
will appear stating that the settings for 
installation are being prepared.  

 

 

 

 

 

6. During the installation process, NVivo 
will list other software that needs to be 
installed. The list will vary from 
computer to computer. Click “Install“ 
to continue the process. 
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7. Once the necessary requirements 
have been installed on your 
computer, you will be ready to 
install NVivo. To do so, Click “Next”. 

 

 

 

 

 

8. Please read the license agreement, 
click “I accept the terms in the 
license agreement“, then click 
“Next”. 

 

 

 

 

9. A dialogue box will appear showing 
the folder where the software files 
will be stored. Click “Next”. 
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10. Another dialogue box will ask you 
which NCapture browser extension 
add-ons you wish to install. 
NCapture will be useful for 
downloading big data from 
websites, the Google search engine, 
Yahoo, etc.  
Check NCapture and click “Next”. 

 

 

 

11. After that, a dialogue box will tell 
you the program is ready for 
installation. Click “Install”.  

 

 

 

 

 

12. Another dialogue box will show you 
the status of the installation 
process. Please wait until the 
process is complete. This will usually 
take around 5–10 minutes.  
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13. Once the process is complete, 
check “Launch NVivo” and click 
“Finish”. Please wait until NVivo 
opens. 

 

 

 

 

 

 

14. When NVivo opens for the first 
time, click “Log into myNVivo”. 
Enter your myNVivo account 
email and password, then click 
“Log in”. 

 

 

 

 

 

 

15. After successfully logging in, 
you will be asked to activate 
your trial license. Click 
“Activate Trial”. A dialogue 
box will tell you your trial 
license is active. Click “OK”. 
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16. You will be asked to fill in your 
user profile. Fill in your name and 
initials, and select the language 
for the user interface (English 
recommended). Check 
“Participate in the Customer 
Experience Improvement 
Program” if you are willing to 
participate in NVivo customer 
surveys. Doing so is not 
obligatory. Click “OK”. 

 

 

17. Your NVivo trial version is now 
ready to use for the next 14 days. 

 

 

 

 

 

2. Qualitative data analysis workflow 

Qualitative research is an iterative process of exploring and analysing data (Figure 1). 
This process starts with importing data, then exploring the data to observe whether 
it has any emerging or recurring patterns. This process is followed by “coding”, or 
labelling and organizing data to identify themes and relationships. The coding 
process can be deductive or inductive. A deductive process involves building a 
codebook or coding guide before the analysis begins (Table 1). For exploratory 
research, codebooks can be created based on data. This is known as an inductive 
process (Yi 2018). The next step involves reflecting on the data and coding results, 
and then visualizing the data. 
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Figure 1. Qualitative data analysis workflow, adapted from QSR International 

 

Table 1. Example of a codebook 

Code Description Example 

Fill in the 
code type  

 

Example: 

“definition” 

Fill in the description to explain the code in 
the first column. 

 

Example: 

Respondents or texts refer to how the 
concept of peatland restoration is interpreted 
or conceptualized. This definition can include 
both social and ecological aspects of 
restoration, such as hydrological and 
vegetation conditions.  

Fill in the sample data that shows 
why it falls into the code category 
(first column). 

Example: 

Restoration is restoring the 
ecosystem to its pre-damaged 
condition. We know we’ll never get 
there, but at least we’ve tried. 

3. NVivo at a glance  

NVivo is a paid software package for analysing qualitative data. It allows teams (up to 
five people) to work together to analyse data through the Collaboration Cloud2 
feature. The software allows researchers and practitioners to analyse data effectively 
and efficiently. Data and analysis results can be visualized in word clouds, tree maps, 
and other forms. NVivo licenses can be purchased individually or collectively through 
institutions. The NVivo learning centre can be accessed here.3 

 
 

2  https://lumivero.com/products/collaboration-cloud/  
3  https://lumivero.com/resources/academy/  

Import

Explore

Code

Reflect

Visualize

https://www.qsrinternational.com/nvivo-qualitative-data-analysis-software/about/nvivo/modules/collaboration
https://www.qsrinternational.com/nvivo-qualitative-data-analysis-software/resources/
https://lumivero.com/products/collaboration-cloud/
https://lumivero.com/resources/academy/
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4. Preparing data4  

Prepare the data you want to analyse in one folder. Data that NVivo can process can 
include: 

• Documents and memos 

Documents and memos can be in the form of interview transcriptions, field 
notes, journal articles, reports and other documents in Microsoft Word 
(.doc, .docx), Rich Text File (.rtf), Text File (.txt), or Portable Document 
Format (PDF) formats. 

• Datasets 

Datasets are structured data organized by rows and columns. They can be 
survey data in the form of spreadsheets (.xls, .xlsx) or metadata from social 
media data collected through NCapture.5 

• Multimedia 

NVivo can also be used to import multimedia, such as audio, video and 
image files obtained from focus group discussions (FGDs), observations, etc. 
Formats compatible with NVivo are: MOV, MP4, AVI, M4A, MP3, WAV, .gif, 
.jpeg, .png, and .tiff. 

• Bibliographies 

If you have done a literature review using EndNote, you can import data in 
the form of EndNote (XML) files into NVivo. 

  

 
 

4  https://help-nv.qsrinternational.com/20/mac/Content/files/files.htm  
5  NCapture is an NVivo browser extension add-on available for Google Chrome and Internet Explorer web browsers. It is 

used to extract data from social media 

https://help-nv.qsrinternational.com/20/mac/Content/files/files.htm
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5. Getting started with NVivo 

5.1.  Creating a new project or opening a recent project 

When you open NVivo, select New Project to create a new project, or Recent 
Projects to open one you 
have recently been 
working on (Figure 2). 
This page also provides 
access to the learning 
centre and support 
resources. 

When you select New 
Project, NVivo will 
redirect you to a new 
page for you to give your 
project a name (Figure 
3). You will also be 
prompted to choose a 
location for saving the 
file. Select Next then Create Project.  

 

 

 

If you want to open a previously saved NVivo file (.nvpx or .nvp), double-click on it 
and NVivo will open it automatically (Figure 4). 

Figure 2. NVivo homepage to open a new or recent project 

Figure 3. Naming the project and specifying its storage location 
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5.2. Importing data 

Once you have 
created a new 
project, you will 
be redirected to 
the NVivo main 
page. To start 
importing data, 
select Import 
(Figure 4), and 
the file explorer 
dialogue box 
will pop up.  

 

 

 

Select the desired file(s), then click Open. In the next dialogue box click Import 
(Figure 5). In this section we will study interview data (in .doc format) and literature 
(in PDF format). These documents can be downloaded from this link.6 

 

 

 

 

 
 

6  https://ipb.link/tradehub-nvivo  

Figure 5. Selecting files for analysis. Click Open, then Import 

Figure 4. Importing data by selecting “Import”, then “Files” 

https://ipb.link/tradehub-nvivo
https://ipb.link/tradehub-nvivo
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5.3. Organizing data 

Imported data can be organized by Case Classification or File Classification. These 
features can be found in the Home menu (Figure 6). The ‘case’ represents a unit of 
observation. For example, a research project may contain cases for people, locations, 
organizations or entities.  

 

 

Figure 6. Data organization options - by case (Case Classification) or file (File Classification) 

 

An example of data organization by Case is shown in Figure 7, where a respondent 

named Ken had been involved in interviews, surveys and group discussions. In this 

example a dedicated Case has been created and assigned the name “Ken”. 
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Figure 7. Data organization by Case 

Source: QSR International 

 

Organizing data through the File Classification option is to group documents by file 
extension type. For interviews and literature, for instance, select File Classification 
on the Home menu, then click New File Classification. Next, complete the 
information in the dialogue box by naming the desired classification class, then click 
OK. Repeat this step when you create a new classification class. In the following 
example where two classification classes – “interview” and “literature” – are created, 
this step is repeated (Figure 8). 
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Figure 8. Classifying files using the File Classification feature 

 

Next, go back to Files from the left of the screen to begin categorizing files. Right-
click on a file and select Classification, then select “interview” or “literature” (Figure 
9). Colour options are available with a right-click and selecting Color. The results of 
created classification classes are then available in the File Classifications menu on 
the left side of the screen (Figure 10). 
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Figure 9. Classifications of files in created categories 

 

Figure 4 File classification results - Under File Classifications, click 
classification class and a list of files in that category will appear 

 

 
5.4. Coding 

5.4.1. Creating codes 

Through the Files tab, open a file that has been classified under “interview”, click on 
it and read it thoroughly. After that, determine what codes will be created from the 
data. To create new code, highlight the part of the text you want to code. Then right-
click and select the Code Selection option. A dialogue box will appear for you to 
create a new code. Click Create New Top-Level Code, and name the new code. Next, 
click Code then Selection to New Code (Figure 11). You can also select the Code 
option from the menu bar at the top of the screen to make it faster. Click Code 
Selection. 
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Figure 5 Tagging data in Codes 

 

After creating a new code, you can fill in the Code Properties, which include name, 
description and colour specifications. Click Codes in the menu on the left of the 
screen. Right-click on the code that has been created then click Code Properties. A 
dialogue box will appear where you can add a description and colour the code (Figure 
12). 
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Figure 6. The Code Properties setting 
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5.4.2. Parent and child codes 

You can also create ‘child codes’, which are more specific classifications under their 
more general ‘parent codes’. An example being: 

Restoration à Parent code 

• Revegetation à Child code 

• Rewetting à Child code 

• Revitalization à Child code 

 

To create a child code, click 
on the Codes tab and select 
an already created parent 
code. Right-click on the 
parent code and select New 
Codes. A dialogue box will 
pop up for you to name, 
complete details of, and 
colour the child code. 

You can check the code 
hierarchy by looking at the 
“Hierarchical name” box, 
which will show the parent 
code first before the child 
code. When ready, click 
“OK” to complete (Figure 
13). 

 

 

 

 

 

 

Figure 7 Creating child codes 
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5.4.3. Highlighting pre-coded data 

To show which parts of an interview have been coded, you can select the Highlight 
and/or Coding Stripes feature. The Highlight feature will highlight text that has 
already been coded, while the Coding Stripes feature will show the code type (Figure 
14). To facilitate the analysis process, activate these two features by selecting 
Highlight then All Coding, and Coding Stripes then All. 

 

 

 

Figure 8 Displaying highlighted text with the Highlight and Coding Stripes features 
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5.4.4. ‘Uncoding’ 

The Coding Stripes feature also allows you to ‘uncode’ or remove codes from parts of 
the text. To do this, right-click on the code, then select Uncode (Figure 15). 
 

 

Figure 9 Using the “Coding Stripes” feature to uncode 

 

5.4.5. Exporting codebooks from coding results 

Codes that have been created using NVivo can be converted and exported into 
codebooks (.docx). This process can be done by selecting the Share tab then 
selecting the Export and Export Codebook options (Figure 16). 

 

Figure 10 Exporting codebooks from coding results in NVivo 
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NVivo will generate a new file in Microsoft Word format (.docx) containing code 
names, descriptions, files and references (Figure 17). 
 

 

Figure 11 Example of a codebook generated from NVivo coding 

 

5.5. Visualizing data  

Data visualization in NVivo can help you identify emerging and recurring themes in 
the early stages of analysis. It also helps in reflection and presentation processes. A 
wide variety of visualizations can be created in NVivo, either automatically or 
manually (e.g., drawing concept maps). This section covers visualizations generated 
automatically from NVivo. Please close the previous files and open the Visualisasi 
Windows.nvp file, which can also be downloaded from this link, to learn about 
visualization features (Figure 18).  

 

Figure 12 Close the previous files and open the provided Visualisasi Windows file 

https://ipb.link/tradehub-nvivo
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5.5.1. Hierarchy charts 

Hierarchy charts visualize code groupings and are used to view proportions of 
themes relating to each other in the data. Select Explore then Hierarchy Chart. A 
dialogue box will appear. Click “Amount of coding for – codes” then “Next”. Then 
check Compare – All codes and Coded to – All files, Externals & Memos, and click 
Finish (Figure 19). 

 

 

 

Figure 19. Steps in bringing up a hierarchical chart for visualization 

 

Once the chart is displayed you can choose either a tree map (Figure 20) or Sunburst 
(Figure 21) visualization. 



 

 

23 

 

Figure 13 A hierarchy chart in the form of a tree map 

 

Figure 14. A hierarchy chart in the form of a sunburst 

 

5.5.2. Word frequency 

‘Word clouds’ visualize words appearing most frequently in codes, files and cases. 
They are ideal for the early stages of research, particularly exploratory research, for 
quickly seeing emerging or repeating patterns. Under the Explore tab (Figure 22), 
select Word Frequency. Then select the number of display words and minimum 
length desired. Next, under the Grouping tab select With stemmed words. To create 
a word cloud from the coding results, click Selected Items for a dialogue box to 
appear. 
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Figure 15 Word cloud visualization – Step 1 

 

In the dialogue box (Figure 23), check Automatically select subfolders and 
Automatically select descendant codes. Then check the codes to choose which ones 
you want to  display. After that click OK. 

 

 

Figure 16 Word cloud visualization – Step 2 

 

When you return to the NVivo main page, click Run Query and NVivo will display a 
summary together with a word cloud (Figure 24).  
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Figure 17. Word cloud visualization – Step 3 

 

If unimportant words like “which”, “this” or “that” enter your word cloud, click 
Summary, right-click on the unwanted word and select Add to Stop Word List so 
NVivo will no longer include it in the word cloud and top word list. After that, click 
Run Query again to display the final word cloud (Figure 25). 

 

 

Figure 18 Word cloud visualization – Step 4 

 

You can change the appearance of the word cloud by selecting the settings from the 
top of the screen below the Word Frequency Query menu (Figure 26). 
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Figure 19 Word cloud visualizations 

 

5.5.3. Searching text 

Text search visualizations are depicted through word trees. This type of visualization 
shows specified or selected words and the contexts in which they are used in 
interviews or literature. For this visualization, select Text Search then click Selected 
Items to specify whether you want to see context in codes, files or cases. Then enter 
the word “fire” and select Special on the right. Then, select AND and enter the word 
“peat”. After that select Include Stemmed Words then Run Query (Figures 27 and 
28). 

 

 

Figure 20 Using the text search query – Step 1 
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Figure 28. Using the text search query – Step 2 

 

To bring up the word tree, close the Text Search Criteria tab, then click the Word 
Tree tab at the right of the screen (Figure 29). 

 

 

Figure 21 Visualization of the words ‘peat’ and ‘fire’ and their contexts in a word tree 

 

5.5.4. Diagrams 

Diagrams visualize comparisons between codes, files and cases. Under the Explore 
tab select Diagrams, click Compare Codes and select the codes to be compared – for 
example, “activity” and “challenge” – then select OK (Figure 30). 
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Figure 22 Bringing up a comparison diagram 

 

To bring up a comparison diagram, check Children in menu under the Comparison 
Diagram tab (Figure 31). 
 

 

Figure 31. A comparison diagram comparing codes 
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6. NCapture 

NCapture is a free web browser extension for Chrome that allows you to collect web 
content for import into NVivo. Support for NCapture for Internet Explorer was 
discontinued in 2020, but you can still install the latest version if needed. Most web 
pages can be captured as PDFs. You can also capture multiple pages from Facebook, 
Twitter and YouTube as datasets, videos and figures. An NCapture file (.nvcx) 
contains the content you retrieved as well as the URL, capture time, and any 
additional information such as description, memo and encoding you specified at the 
time of retrieval. Some captures from social media sites generate a lot of files after 
being imported into NVivo. For example, Facebook content can contain NVivo and 
Figure datasets.  

Viewing social media data - You must authorize NCapture when retrieving from 
Facebook or Twitter for the first time.  

NCapture authorization - Depending on your version of NVivo, some types of 
captured content cannot be imported into your project.  

 

6.1. Installing Ncapture in Chrome 

If you have installed NVivo, NCapture may have been installed on your computer as 
part of the NVivo installation. Otherwise, you can install it manually. You will need 
Chrome 44 (or later) to use NCapture for Chrome. 

1. Open NCapture for 
Chrome in the Chrome 
Web Store. 

2. Click the Add to Chrome 
button and confirm in the 
dialogue box. NCapture 
will then be added to 
Chrome, with an icon in 
the toolbar. 

 

You do not need to install NVivo to use NCapture. For example, you can still ask a 
research assistant who does not have NVivo to install NCapture and collect Tweets. 
They can then send NCapture (.nvcx) files to you to import into your NVivo project. 
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6.2. Capturing content with NCapture 

You can import social media content from Facebook, Twitter and YouTube that you 
have collected with NCapture. 

1. In your browser, open the content you want to capture. 

2. Click the NCapture button at the top of your browser. 

 

 

 

 

 

 

 

 

 

 

3. Select the document result type. Depending on the type of content you are 
viewing, you may see different capture options.  

4. Review and rename files. 

5. You can enter a short description or memo: 

a. Description becomes one of the file properties in NVivo. 

b. Memos you enter become linked memos when files are imported. 

6. Optionally, enter one or more codes (“nodes” in previous versions of NVivo) 
to encode the contents. When you import content into NVivo, the entire file 
is encoded into this. 

a. If you enter a code that does not exist in your project – or mistype 
its name – a new code is generated. 

b. If coding into an existing code, enter a hierarchical code name – for 
example, “trade”\”palm”. 

7. Click Capture. The retrieved content is saved as an NCapture (.nvcx) file that 
you can import into your NVivo project. 
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6.3. Social media account authorization (Twitter) 

A dataset is created containing Tweets you have captured. Any hyperlinks in the 
Tweet will be noted. If the Tweet includes a link to a media file, the media file is not 
imported into your project, but you can access it from the hyperlink. 

If the Tweet is a search result on Twitter, you can click the link in the Search Terms 
column in the dataset to perform a new search on Twitter. 

By default, user information such as gender or location will be imported along with 
Tweets. If this is not relevant to your research, you can change this behaviour in the 
project properties. 

Before obtaining data, the account must first be authorized. 

 

 

7. Further reading 

Yi E. 2018. Themes don’t just emerge – Coding the qualitative data. 
https://medium.com/@projectux/themes-dont-just-emerge-coding-the-qualitative-
data-95aff874fdce (11 November 2020) 

QSR International. NVivo for Mac – Getting started guide. 
http://download.qsrinternational.com/Document/NVivo11forMac/11.1.0/NVivo-for-
Mac-Getting-Started-Guide.pdf (11 November 2020) 

Jackson K and Bazeley P. 2019. Qualitative data analysis with NVivo. Sage. 

https://medium.com/@projectux/themes-dont-just-emerge-coding-the-qualitative-data-95aff874fdce
https://medium.com/@projectux/themes-dont-just-emerge-coding-the-qualitative-data-95aff874fdce
http://download.qsrinternational.com/Document/NVivo11forMac/11.1.0/NVivo-for-Mac-Getting-Started-Guide.pdf
http://download.qsrinternational.com/Document/NVivo11forMac/11.1.0/NVivo-for-Mac-Getting-Started-Guide.pdf


  

 
 

1 

Table of contents  

1. KUMU ACCOUNT REGISTRATION TUTORIAL ..... 36 

1.1.  KUMU REGISTRATION .......................................36 

2. INTERPRETING BASIC DATA AND PREPARING FOR 
SOCIAL NETWORK ANALYSIS WITH KUMU ........ 40 

3. FILLING IN ELEMENTS SHEETS ........................... 41 

4. FILLING IN CONNECTIONS SHEETS ..................... 42 

5. ANALYSING SOCIAL NETWORK DATA WITH 
KUMU (VIA EXCEL FILE IMPORTS) ..................... 46 

5.1. LOGGING IN TO YOUR KUMU ACCOUNT .................46 

5.2. CREATING NEW PROJECTS ON KUMU ....................47 

6. IMPORTING DATA FROM EXCEL DOCUMENTS TO 
KUMU, AND BASIC VISUALIZATION SETTINGS... 53 

7. CENTRALITY ANALYSES ..................................... 57 

8. SETTING VISUALIZATIONS OF CENTRALITY 
ANALYSIS RESULTS TO AID INTERPRETATION ... 59 

9. EXAMPLES OF VISUALIZATION AND 
INTERPRETATION OF SOCIAL NETWORK 
ANALYSIS RESULTS USING KUMU ..................... 62 

 

Training materials 

ipb.link/tradehub-kumu 

 

https://ipb.link/tradehub-kumu


  

 
 

36 

1. Kumu account registration tutorial 

Kumu (https://www.kumu.io/) is a website-based software package created by Jeff 
and Ryan Mohr in the United States in 2011. It can be used for visualization of 
stakeholder mapping, systems mapping, social network mapping, community asset 
mapping and concept mapping. Kumu offers advantages in enabling users to provide 
attractive visualizations for complex data, and to create visual databases. Kumu also 
has several automated analysis features, for example, for metric calculations in social 
network analysis, community detection and clustering. In addition, Kumu has a 
feature to create online presentations that make it easy for you to share the results 
of your research. Basically, Kumu is a free platform, but your data will be publicly 
available. If you want to make your data available personally, you can choose a paid 
service. 

Here are the steps to register a Kumu account: 

1.1.  Kumu registration  

1. Open the Kumu website 
through your browser 
https://www.kumu.io/  

 

2. Enter the JOIN FOR FREE menu 
in the upper right hand corner.  

 

 

3. Fill in the data needed for registration. This registration page can also be accessed 
directly at the following link https://www.kumu.io/register  

https://www.kumu.io/
https://www.kumu.io/
https://www.kumu.io/register
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First and last name 

First name and last name, example: Miftah 
Rahman 

Email address 

Your email address, example: 
miftahrahman@email.com 

Choose a username 

Choose the username you want to use, 
you can use numbers 0–9 and/or letters 
a–z and hyphens (-). Examples of 
usernames are miftahrahman, miftahr20, 
miftah-rahman 

Choose a password 

Enter the password you will use. You will 
need to use this password each time you 
log in to your account on the Kumu 
website. 

If you want to receive a monthly newsletter from Kumu, you can check “Yes, I'd like 
to receive Kumu’s monthly newsletter”. You do not need to check it if you do not 
want to receive the newsletter. 

After you have filled in all the data, click “I’m not robot” for verification and Create 
your free account. 

4. Your account has been successfully created if the following DASHBOARD page 
appears. 
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5. You can learn more about Kumu features at Learn the essentials 
https://docs.kumu.io/  

6. Open the Kumu website through your browser https://www.kumu.io/ and click 
SIGN IN. 

 

 

 

7. On the sign in page, fill in your username or email address and the password you 
used to register, then click Sign in. 

 

 

8. After signing in successfully, you will be connected to the dashboard page of your 
Kumu account. 

https://docs.kumu.io/
https://www.kumu.io/
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40 

2. Interpreting basic data and preparing for social network analysis 
with Kumu 

1. The TRADE Hub_7Nov20_Data KUMU_A and TRADE Hub_7Nov20_Templat KUMU 
Excel files can be downloaded here. 

2. The TRADE excel file Hub_7Nov20_Data KUMU_A contains a matrix of data from 
social network surveys to actors who have been identified as having a role in the 
governance of Commodity A. Data is in the form of an adjacency matrix. 

 

 

Figure 1. How to interpret survey result data (Adjacency matrix) 

 

Column A is a list of actors as subjects/senders, and columns in row 1 list actors 
as objects/receivers (Figure 1). The number 1 indicates the subject/sender actor 
stating there is a commodity governance interaction with the object/receiver 
actor, whereas the number 0 means there is no interaction.  

Examples: The 1 in cell C2 means the central government stated that it has 
direct interaction with local governments in the governance of Commodity A, 
while the 0 in cell D2 means the central government stated it has no direct 
interaction with farmers. 

 

3. As the survey data will be analysed with Kumu, adjustments are made to the 
Kumu template file (TRADE Hub_7Nov20_Template KUMU). The Kumu template 
contains two sheets; the first for entering data elements (Figure 2) and the 
second for data connections (Figure 3). 

https://ipb.link/tradehub-kumu
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Figure 2. The first sheet of the Kumu template (elements data) 

 

Figure 3. The second sheet of the Kumu template (connections data) 

 

3. Filling in elements sheets 

Elements in Kumu are actors/stakeholders that constitute the focus of analysis, and 
can be individuals or organizations. The elements sheets contain lists of 
actors/stakeholders constituting the basic data. If needed, to enrich the analysis or 
visualization of an element, detailed data – such as name, type, description, tag, 
organization, etc. can be added in subsequent columns. In Kumu, element attributes 
are called fields. 

Fill in the element sheets containing lists of actors according to the data. The 
example in Figure 4 below is for Commodity A. To shorten names, IDs can also be 
used. 
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Figure 4. Filling in elements sheets in the Kumu templates 

4. Filling in connections sheets 

Connections in Kumu are interaction relationships between actors/stakeholders that 
constitute the focus of analysis. The connections sheets contain social network data 
in the form of an edgelist matrix. As survey data takes the form of an adjacency 
matrix, it needs to be converted to an edgelist matrix. Please refer to Tip Box 2 for 
how to convert matrices using a web-based matrix expander. 

Tip Box 1. Important notes in filling in elements sheets 

• Labels are basic information for analysis with Kumu. They must always be filled 
in and located in the first column (column A in Excel). The label is the name of 
the actor/stakeholder that will be displayed on the Kumu visualization map.  

• Fields such as label, type etc. should always be present in the first row. 

• There should be no column breaks or empty rows. 

The element label is the name of the actor/stakeholder that will be 

displayed in the visualization. This can be shortened by using an ID. 

The label is the basic information for Kumu, and must be filled in. 

Examples of additional information needed 
to enrich the analysis or visualization 
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Tip Box 2. Two quick ways to convert an adjacency matrix to an edgelist matrix: 

1. Through the website https://matrix-expander.netlify.app/  

a) Set up an adjacency matrix in an Excel file as shown below. Actor/stakeholder/element/label 
names should not contain spaces, and make sure the data position starts in the top row and 
the first column. 

 

b) Go to the website https://matrix-expander.netlify.app/ 

 

c) Click start or drag the cursor down, then upload the Excel file by clicking Upload matrix. The 
upload box will turn green once your file has been uploaded successfully. 

 

 

https://matrix-expander.netlify.app/
https://matrix-expander.netlify.app/
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d) Check Directed for matrix connections. 

 

e) Click Expand. 

 

f) Scroll down and download the result file, in Excel xlsx format, for example. 

 

g) Copy the sheet containing the converted matrix to the connections sheet in Excel for 
Kumu. 
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Figure 5. Filling in connections sheets in the Kumu templates  

 

Figure 5 shows an example of filling in a connections sheet for a Kumu template. The 
sheet lists all data on relationships/interactions between actors/stakeholders. Data in 
column A under the heading from is the subject/sender, while data in column B 
under the heading to is the object/receiver. Strength is usually the value of 
sociometric choices, which usually indicates a measure of how specific the 
relationship between an actor/stakeholder is. Sociometric choices data are usually 
obtained at the time of surveys through rating or ranking questions. If needed, to 
enrich the analysis or visualization of an element, detailed data – such as name, type, 
description, tag, organization, etc. can be added in subsequent columns. Connection 
attributes are called fields in Kumu. 

  

Sociometric choices, if needed. 
A measure of how strong relationships between specific 
actors/stakeholders are. This is usually asked in surveys using ratings 
and rankings. 
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5. Analysing social network data with Kumu (via Excel file imports) 

5.1. Logging in to your Kumu account 

1. Open the Kumu website at https://www.kumu.io/ through your browser and click 
the SIGN IN menu.  

 

 

Figure 6. KUMU website home page 

  

2. On this page, fill in your username or email address and the password you used to 
register, then click Sign in. 

 

Figure 7. Log in page on the Kumu website 

https://www.kumu.io/
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5.2. Creating new projects on Kumu 

1. After signing in you will be connected to the Dashboard page of your Kumu 
account. Click New Project. 

 

Figure 8. The Dashboard page in Kumu 

 

2. Fill in project information in the Project name and Project description fields. 
Check Public in the pricing plan selection. 

 

 

Figure 9. New project page on the Kumu website (1) 
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3. Click Create project in workspace to open a worksheet. 

 

 

Figure 10. New project page on Kumu website (2) 

 

4. On the pick a template page, slide the cursor down and select a stakeholder 
template by clicking on it, then click USE THIS TEMPLATE to go to the Kumu 
worksheet. Please refer to Tip Box 3 for features in Kumu worksheets. 

 

 

 

Figure 11. Template selection page for a new project in Kumu 
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Tip Box 3. Features of a Kumu worksheet 

 

The Add button: For adding data to the map (element, connection, loop, sketch, import) 

 

The menu in the upper left corner: Shows the main settings 
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 Map settings and map view in the upper left corner: For selecting map and preset visualization 

settings, and creating new maps or presets in the same worksheet 

 

Sidebar menu: Quick options to go to map settings 

 

 Menu in the middle of the file: For hiding the sidebar so only the map is shown 
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. 
Map menu: For displaying map visualization settings 

 

Wizard menu: Serves as a help menu, displaying guides and answers to FAQs 

 

Settings menu in the lower left corner: Displays general settings 

 



 

 

52 

 

Cube icon menu: For displaying the Social Network Analysis and Community Detection menus 

 

Tables menu: For displaying data in table/matrix form 

 

More menu: Displays menu for exporting or importing data, fullscreen view, preview mode, etc. 
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6. Importing data from Excel documents to Kumu, and basic 
visualization settings 

1. You can import data from a pre-prepared Excel file by clicking the Add button 
then Import. 

 

 

Figure 12. Importing data using the Add button 

 

2. To import a file to Kumu, under the Import menu, click Choose File, select a file, 
then click Import spreadsheet to upload the file. 

 

 

Figure 13. Importing data files to Kumu 
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3. During the import process, Kumu will automatically review the data for errors. If 
no errors are found, continue the data import by clicking Save Import. 

 

 

Figure 14. Error checking during the data import process 

 

4. Once the data import is complete, Kumu will automatically display a map of the 
social network. Click the menu on the sidebar to rename the map, then click 
Submit. 

 

Figure 15. Map renaming process 
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5. You can adjust the map’s visualization settings by clicking the Settings, then 
COLOR BY and selecting Element Type. Click the expand selection toggle on the 
far right of the COLOR BY row and select the desired colour set. Change Theme to 
dark to provide better contrast, then click SAVE to save the settings. 

 

 

 

 

Figure 16. Map visualization setup process (1) 
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Figure 17. Map visualization setup process (2) 

 

6. Save the map visualization as the default preset view and rename it “Default” by 
clicking the settings menu in the upper right corner of the screen, selecting 
Rename view, and clicking Submit. 

 

 

Figure 18. Resetting the default preset view 
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7. Centrality analyses 

1. You can perform a centrality analysis by clicking the Cube icon in the lower right 
corner, selecting Social Network Analysis and moving your cursor to the sidebar. 

 

 

 

 

Figure 19. Social network metrics analysis in Kumu (1) 
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2. Click Choose a metric, for example, Degree, then click “Discover the connectors / 
hubs to run automatic calculations. Then copy the resulting degree centrality 
calculation table to another document. 

 

 

 

Figure 20. Social network metrics analysis in Kumu (2) 

 

3. Repeat steps 1 and 2 to calculate the other metrics, namely closeness and 
betweenness centrality. 
 

 

Figure 21. Selecting social network analysis metrics in Kumu 
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8. Setting visualizations of centrality analysis results to aid 
interpretation 

1. After the three centralities have been analysed, click Settings then the left corner 
menu under Settings, and select Duplicate view to create different views with 
the same basic settings. Change the name to “Degree centrality” and click 
Submit. 

 

 

 

 

Figure 22. The duplicate view process 
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2. Once the view is saved with a new name, click SIZE BY in the settings and select  
degree. This will adjust the size of elements on the map to accord with their 
degree centrality values. Click SAVE. 

This visualization makes element size representative of degree centrality value. 

  

 

Figure 23. Adjusting element sizes 

 

3. Click Zoom to fit to ensure appropriate proportions for the map view. 

  

 

Figure 24. Adjusting map proportions 
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4. To save the map view as a Figure file, click the More menu in the lower right 
corner, select Capture screenshot, then right-click and click Save image as. 

You can also save the map view as a .pdf file by clicking the More menu and 
selecting Download PDF. 

 

 

 

Figure 25. Saving social network analysis map visualizations 

 

5. Repeat steps 1–4 for closeness and betweenness centrality results. 
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9. Examples of visualization and interpretation of social network 
analysis results using Kumu 

Examples of social network analysis visualizations for actors involved in the 
governance of Commodity A are shown below. 

 

Figure 26. Social network analysis 
visualization map depicting degree centrality 

 

 

 

 

 

 

  

Figure 27. Social network analysis 
visualization map depicting closeness 
centrality  

 

 

 

 

 

 
 

Figure 28. Social network analysis 
visualization map depicting betweenness 
centrality  
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Table 1. Degree, closeness and betweenness centrality calculation results 

 

The social network analysis results examples identify private companies as highly 
important actors in the network as they act as local connectors, spreaders/sensers, 
and brokers/bottlenecks. All actors in the network have good connectivity, except 
farmers and brokers. All actors have sufficient proximity in the dissemination of 
information within the network. Private companies, local governments and farmers 
are key actors in the successful flow of information in the network. 

Further information on setting up visualizations and other features in Kumu can be 
accessed via the following link: https://docs.kumu.io/. 

Tip Box 4: Guide to interpreting degree, closeness and betweenness 
centrality values 

Metric Interpretation 

Degree 
centrality 

Identify the local connector/hub 
Shows the number of relationships that an element has. In general, elements 
with high degree scores are well connected within the network, but are not 
necessarily the highest in the wider network.  

Closeness 
centrality 

Identify the spreader/senser 
Shows the distance of one element to another. Indicates the proximity of an 
element to other elements in the network. In general, elements with a high 
closeness value can spread information into the network more easily and 
have a high tendency to be able to know what is happening in the network.  

Betweenness 
centrality 

Identify brokers/bottlenecks 
Measures the number of times an element is between relationships between 
two other elements. In general, elements with a high betweenness value 
have more control over the flow of information and act as key links in the 
network. A high betweenness value also indicates that the element can be a 
point that supports the failure of information flow in the network. 

 

https://docs.kumu.io/
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1. UCINET and NetDraw installation tutorial 

UCINET is a social network 
data processing program 
created by United States-
based software company 
Analytic Technologies. The 
program was developed by 
Lin Freeman, Martin Everett 
and Steve Borgatti, and was 
first released as UCINET 
version 4.0 in 1992. At the 
time of writing, the most recent iteration of UCINET is version 6.742. UCINET can be 
downloaded for free from a page provided by Analytic Technologies at 
https://sites.google.com/site/ucinetsoftware/download. The page also provides 
tutorials on using this software.  

Select the latest version of the 
UCINET program from the Versions 
bar at the top of the page, and click 
Download. When the setup 
dialogue box appears, click Save 
File to download the UCINET 
execution file. 

Once the download is complete, click the UCINET document to perform the 
installation. Click the Immediate Installation button. When the next dialogue box 
appears, select Yes. 

  

 

https://sites.google.com/site/ucinetsoftware/download
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The Setup dialogue box will pop up as below. Please read the terms and conditions, if 
you agree to the installation process, select Yes, I do. The installation process will 
take a few minutes to complete. 

 

 

 

Once installation process is complete, the following notification will appear. Click 
Thanks!. 
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To manage the storage of documents generated by the UCINET program, select Set 
Default Folder from the menu that appears when you click the storage icon in the 
lower right corner. Select your desired storage folder to ensure all UCINET analysis 
result documents are stored in the same folder.  

 

 

 

The free UCINET download is a 60-day trial version with no registration number. Paid 
versions with registration numbers are also available for purchase. For information 
on prices and available versions, click on the Purchasing bar at the top of the page. 
The only difference between the trial and paid versions of UCINET is their period of 
validity.  

As NetDraw has become an integral part of the UCINET program, it does not require 
a separate installation.  
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2. Features and tools in UCINET and NetDraw 

2.1. UCINET worksheets 

UCINET is an easy-to-use social network data processing program. Once you have 
successfully installed the program, you can click the UCINET icon to bring up the 
display shown below. 

  

Figure 1. UCINET display 

 

The most commonly used menu in conducting network analyses is the Network 
menu, which allows analyses of whole and ego networks. The UCINET worksheet 
toolbar shown below makes it easier for users to input and process data. 

 

Figure 2. The UCINET toolbar  

 

a. Exit: To exit UCINET 

b. Matrix editor: For inputting data on attributes for each actor in a network 

c. DL editor: For inputting data on relationships between actors produced by 
researchers. Data inputting can be done directly in the DL editor box, or copied 
and pasted from Microsoft Excel. 

Area to display commands or analyses performed on data 
 

UCINET tutorial and book on Social Network Analysis 
 

Creators of UCINET 

Menu 
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d. Open datasets: For opening files saved in dataset format. 

e. Network: For displaying different social network analyses 

f. Quickstart: For opening dataset files and displaying them in the form of 
sociograms 

g. NetDraw: For displaying NetDraw software spreadsheets  

 

2.2.  NetDraw worksheets 

NetDraw is a program for displaying social network data analysis results in the form 
of sociograms. Developed by Borgatti, NetDraw is integrated with the UCINET 
program. You can open a NetDraw worksheet by clicking the  icon in UCINET. 

  

 

Figure 3. NetDraw worksheet view 

 

The most frequently used menus in NetDraw are the File, Analysis and Properties 
menus. The use of these menus is explained in sub-chapters below.  

 

 

 

 

Area for displaying sociograms 

Brings up UCINET filenames displayed in 

sociogram form 

 

Displays the names of actors on the network 

 

Number of relationships 

that exist in the network 
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NetDraw provides a toolbar that allows users to modify the appearance of 
sociograms. 
 

  
Figure 4. The NetDraw toolbar 

 

Icons on the NetDraw toolbar function to: 

a. Open UCINET network dataset: For opening relationship files saved in 
UCINET dataset format 

b. Open UCINET attribute dataset: For opening actor attribute files saved in 
UCINET dataset format 

c. Resize to fill area: For adjusting the size of sociograms to the size of the 
NetDraw page 

d. Move all points: Provides a menu for rotating a figure, zooming in and out, 
adjusting the position of a figure to the NetDraw page, and changing the 
network view 

e. Zoom in – Zoom out: For zooming in and out of a sociogram figure 

f. Kawai: Functions to display different forms of figures. 
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3. Inputting relationship data 

UCINET use is generally divided into three types: Data entry (inputting); network data 
analysis; and creating sociometric figures using NetDraw. At this stage the data 
obtained is entered in numerical form (usually in nominal or ordinal measurement 
scales). Data entry can be done through facilities in UCINET, or using other software 
such as Microsoft Excel and copying into UCINET. Files analysed by this software will 
be saved as datasets. An important consideration when inputting data into UCINET is 
the data format used. The three most widely used formats are Full Matrix, Nodelist, 
and Edgelist. The direction of data must also be considered in the data entry process, 
as in relationships there are actors who act as subjects (active) and others who act as 
objects (passive). 

 

3.1. Full Matrix 

This format is created in the form of a rectangular matrix in which actors are 
positioned in rows and columns. Actors are paired with others based on their 
relationships. The number 0 indicates no relationship, while the number 1 indicates 
the existence of a relationship. Actors acting as subjects are positioned in rows, while 
those acting as objects are placed in columns. This binary format for relationship data 
is widely used to perform various network analyses in UCINET. 
  

 
Figure 5. Data displayed in Full Matrix format 

 

Relationship data: 0 indicates no relationship 
while 1 indicates the presence of a relationship 

Subject/Active 

Object/Passive 
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3.1.1. Nodelist 

This format is created by creating a list of actors (nodes) and their relationships. The 
names of actors and their relationships with other actors are written horizontally. 
The advantage of using this format is that the possibility of actors being left out or 
overlooked during data entry can be avoided. Consequently, this format is often used 
if there are large numbers of actors. The downside to this format is that it cannot 
display values for relationships. 
  

 
Figure 6. Data displayed in Nodelist format 

 

Actors playing roles as subjects are placed in the first column, while those playing 
roles as objects are placed in the second and subsequent columns. The disadvantage 
of this format is that values of relationships between actors cannot be displayed. 

 

3.2. Edgelist 

This format is similar to Nodelist, the difference being that actors’ names and 
relationships with other individuals are written vertically (one per row). The 
advantage of using this format is that we can list large numbers of actors and display 
relationship values. Actors playing roles as subjects are listed in the first column, 
while those playing roles as objects are listed in the second column. This format only 
lists related actors, so if data is in nominal scale form, only the number 1 will be 
displayed. Numbers with ordinal scales, like those in Figure 7, show the strength of 
relationships between actors.  

 

Object/Passive: actors related to 
subjects 

 

Subject/Active 
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Figure 7. Data displayed in Edgelist format 

 

Once familiar with the formats used in UCINET, you can choose the one most 
applicable to your needs for the data entry process. Inputting data in UCINET starts 
by clicking the DL Editor ( ) icon on the toolbar, after which the DL Editor 
spreadsheet will appear (Figure 8). The data entry process can be carried out either 
by copying data from Excel using Ctrl + C in the Excel file and Ctrl + V in the DL Editor 
spreadsheet, or clicking Paste under the Edit menu. Select the appropriate data 
format in the Data Format field on the right side of the spreadsheet. If the data being 
entered is in matrix form, you should select the matrix data format in the same field. 

 

 
Figure 8. DL Editor menu for entering relationship data 

 

Relationship data: this ordinal data shows the closeness or strength of 
relationships between actors 

 

Subject/Active 

Object/Passive 
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Once all data has been entered, click the  icon to finalize data entry. Save the 
entered data by clicking the File menu and selecting Save UCINET Dataset, or by 
clicking the  icon and selecting the desired storage folder. To check the data 
entered is correct and the UCINET format it has been saved in, select the Open 
Dataset ( ) icon to display the data in text form (Figure 9). 

 
Figure 9. Displaying the entered dataset and its format 

 

3.2.1. Entering actor attribute data 

UCINET can also be used to analyse relationships between actors by attribute, such 
as age, gender, position, regional origin, etc. Attribute data entry begins by typing 
actors’ names in the first column and their attributes in the next column. Each 
attribute must be coded as UCINET can only process data in numeric form. To enter 
actor attributes, click the Matrix Editor ( ) icon, and enter the attribute data into 
the available fields. Actor attributes can either be typed directly in the Matrix Editor, 
or copied and pasted from Excel. If the data comes from an Excel file, click the  icon 
and find the file to analyse. Data copied from the Excel file can be entered by clicking 
the Edit menu and selecting Paste, or by using Ctrl + C and Ctrl + V commands. Once 
data entry is complete, click the  icon to save the file. 
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Figure 10. Matrix Editor for inputting attribute data 

 

 

3.2.2. Data transformation 

A number of network analysis calculations require certain data requirements. For 
example, the calculation of network density requires dichotomous/binary data. If the 
data we have is ordinal/ranking data, a process is necessary to transform the data to 
match conditions required by the calculation. UCINET provides a menu to transform 
valued (ranking) data into binary data. 

  

 
Figure 11. Menu for data transformation 

 

Attribute code: actors with the same 
attributes are assigned the same codes 

 

Actors’ 
names 
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Under the Transform menu, select Dichotomize for a dialogue box to appear (Figure 
12). Next, enter data values in the Input dataset (X) field and select the storage 
location in the Output dataset (Y) field. 

  

 
Figure 12. Dialogue box on data transformation 

 

4. Whole network analyses 

Whole network analyses discussed in this section are structural analyses of network 
density, centrality (the positions of actors in relation to others), and cliques. 

 

4.1. Network density 

Network density is the ratio between the number of bonds present (actual) and the 
number of bonds that arise when all actors in the network relate to each other 
(potential). For such analyses, data must be binary (0 and 1) showing the presence or 
absence of relationships between actors. We can perform a network density analysis 
by clicking the Network menu and selecting Whole network & cohesion, Density and 
Density Overall (Figure 13). 

When the dialogue box appears, enter the file for analysis in the Network Dataset: 
field and select a storage folder for analysis results in the Output densities: field 
(Figure 14). 

  



 

 

77 

 

Figure 13. Menu for analysing network density 

 

 
Figure 14. Network density analysis dialogue box 

  
Figure 15 shows the results of a network density analysis in UCINET. The data shows 
an average network density of 0.641, or 64.1%, indicating the network having a 
relatively low density where many actors or members of the network have no 
relationships or are even unfamiliar to each other. 
 

 

  

Figure 15. Network density analysis results 

C 
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4.2. Cliques 

A clique is a grouping of actors in a network where all actors in the group interact 
with each other. To identify cliques in a network, click the Network menu and select 
Subgroups, then Cliques. 
  

 
Figure 16. Menu for analysing cliques 

 

When the dialogue box (Figure 17) appears, enter the file to be analysed in the Input 
dataset: field. In the second field, enter the minimum number of members per 
clique. If we choose three, then only cliques with three or more actors will be 
displayed. The next step is to select a storage location folder for each output. 

 

 

Figure 17. The Cliques dialogue box 
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Analysis results in Figure 18 show five cliques comprising at least three actors existing 
in the network. Actors can be members of more than one clique. This analysis 
identifies Jana and Petr_Ne as actors having strong relationships with various actors 
since they are members of all five cliques. They also have potential to be liaisons 
between actors from different cliques. 
 
 

 
Figure 18. Analysis results showing numbers and members of cliques in the network 

 

 

 
Figure 19. Clique analysis results by actor 

1. Diagonal matrix: shows how many times 
actors are members of cliques 

 

2. Numbers outside the diagonal matrix show 
how many times actors in rows and 
columns are joined in the same cliques 
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4.3. Degree centrality 

The results of this analysis show the number of relationships between ‘out degree’ 
and ‘in degree’ actors. Actors with the highest degrees of centrality are popular 
actors in social networks as they have the highest numbers of relationships with 
other actors. To perform a degree centrality analysis in UCINET, click the Network 
menu, and select Centrality, then Degree. 
 

 

Figure 20. Menu for analysing degree centrality 

 

The command will bring up a dialogue box like the one in Figure 21. Next, enter the 
file to be analysed in the Input Network: field and select the output storage location 
in the desired folder. 

 

 

Figure 21. Degree centrality analysis dialogue box 
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Analysis results in Figure 22 below show Jana and Petr_Ne having relationship values 
of 12 and degree centrality degree values of one, meaning both actors have 
relationships with all actors in the network. Therefore, Jana and Petr_Ne are central 
actors with potential to accelerate the dissemination of information or resources to 
other actors in the network. 

  

 
Figure 22. Degree centrality analysis results 

 

4.4. Betweenness centrality 

Betweenness centrality analyses show actors’ positions as intermediaries in 
relationships between other actors in a network. Actors who act as intermediaries 
are important members of a network as certain actors cannot connect with others 
without an intermediary. Analysis of betweenness centrality is important because it 
deals with the control and manipulation of information by actors who act as 
intermediaries. To perform a betweenness centrality analysis in UCINET, under the 
Network menu, select Centrality, then Freeman Betweenness, and Node 
Betweenness. 
  

 
Figure 23. Menu for analysing betweenness centrality 



 

 

82 

Again, the next steps are selecting files for analysis and choosing the desired storage 
folder. Analysis results in Figure 24 below show seven actors having roles as 
intermediaries, with Jana and Petr_Ne being the most dominant. This means Jana 
and Petr_Ne are central actors with potential to control the network and manipulate 
information as communication to actors in the network must pass through both of 
them. 

 

 

Figure 24. Betweenness centrality analysis results  

 

4.5. Eigenvector centrality 

Eigenvector calculations determine how important other persons associated with 
actors are, as defined by the numbers of relationships they have. Unlike degree 
centrality, which counts how many actors (nodes) are associated with others, 
Eigenvector focuses on how popular nodes are networked with actors. To perform an 
Eigenvector centrality analysis in UCINET, click the Network menu and select 
Centrality, then Eigenvector centrality. 
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Figure 25. Menu for analysing Eigenvector centrality 

  

Analysis results show Jana and Petr_Ne having higher Eigenvector values than other 
actors, meaning they have relationships with important people in the network. Based 
on all the centrality analyses, Jana and Petr_Ne are central actors as they both have 
many relationships, relate to important people in the network, and act as 
intermediaries. 

 

 

Figure 26. Eigenvector centrality analysis results 
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5. Ego network analyses 

Ego network analyses focus on the positions of actors (egos) in relation to others 
(alters). The type of ego network analysis discussed in this section is a brokerage 
analysis. 

 

5.1. Brokerage 

Brokerage analyses are intended to identify which egos play roles as intermediaries 
(brokers) between alters, and the type of intermediary function those egos play. To 
perform a brokerage analysis, click the Network menu and select Ego Networks, 
then G&F Brokerage roles. 

 

 

Figure 27. Menu for analysing brokerage 

 

A dialogue box will appear like the one in Figure 28. In the Network dataset: field, 
select files containing relationship information between actors (used in previous 
analyses). In the Attribute data set: field, select the actor attribute file saved in 
UCINET dataset format. In the three Output fields, select the desired folder(s) for 
saving the analysis results. 
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Figure 28. Brokerage analysis dialogue box 

 

Brokerage analysis results in Figure 29 based on the attributes of each actor show the 
network being divided into five groups separated by dotted lines. The first group 
comprises only Jana, who is a former prime minister. The second group consists of 
Ivan, Petr_Tl and Marek, who are party deputies. The third group comprises Ondrej, 
Roman_Ban, Jan, Milan and Lubomir who are intelligence agents. The fourth group is 
Petr_Ne, who is a government official, while the fifth group comprises Ivo, 
Roman_Jan and Tomas, who are godfathers.  

Jana and Petr_Ne have the most connections with other actors, with both serving as 
consultants and liaisons. Consultants, namely Jana and Petr_Ne, are liaisons between 
nodes belonging to the same group. Jana, for example, is a liaison between Milan 
and Lubomir, both of whom are intelligence agents. Liaisons, namely Jana and 
Petr_Ne, are connectors between nodes belonging to different groups. Petr_Ne, for 
example, is a liaison between Ivo, who is a godfather and Marek, who is a party 
deputy. 
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Figure 29. Brokerage analysis results 

 

 

6. Creating sociograms using NetDraw 

Results of network analyses in UCINET can be visualized very easily in the form of 
sociograms showing relationships between actors in the network by using NetDraw. 
Click the  icon in the UCINET toolbar to open the NetDraw page. 

 

6.1. Whole network visualizations 

Documents stored in UCINET datasets can be opened in NetDraw in different ways. 
Firstly, by clicking the File menu, and selecting Open, Ucinet dataset, then Network. 
Attribute data can also be opened under the File menu by selecting Open, then 
Attribute data, as long as relationship data (network) is opened beforehand. This 
attribute data will not be displayed in the NetDraw worksheet, but is used to adjust 
sociogram visualizations of analyses that use actor attributes. Another, easier option 
for opening relationship files is to click the  or  icons, while attribute files can be 
opened by clicking the  icon. 
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Figure 30. Menu for visualizing relationships and actor attributes 

 

Once a sociogram appears in a worksheet, it can be saved in Metfile, Bitmap, jpeg, or 
PNG format. To save a sociogram, under the File menu, select Save Diagram As and 
choose the desired image file format. 
 

 
Figure 31. Menu for saving whole network sociograms 

 

6.2. Ego network visualizations 

NetDraw can also display networks showing relationships between specified actors 
(egos) and other actors (alters). To display an ego network, click the Ego icon on the 
toolbar. A dialogue box will appear showing the names of actors in the network 
(Figure 32). If we want to select one of the actors in the network, check the box next 
to their name. NetDraw will only show all relations and actors related to that actor. 
The example sociogram shows the actor named Roman having eight alters. 
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Figure 32. Ego network view in NetDraw 

 

6.3. Changing the appearance of lines/edges/links that characterize relationships 

The appearance of lines showing relationships between actors in sociograms can be 
altered for aesthetic purposes as well as to highlight certain aspects of the network. 
We can change the colour, size, style, directional shape and labelling of lines. 
Measures and labels are usually used to indicate the strength of ties between actors. 
For example, if we want to change the size/thickness of a line based on the strength 
of the relationship between actors, under the Properties menu, select Lines, Size, 
and then Tie strength. NetDraw will display networks with different line thicknesses 
according to the strengths of relationships between actor, as depicted in Figure 33. 
 
 

 

Figure 33. Menu for changing line thickness by strength of relationship, and a resulting 
sociogram 
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6.4. Changing the appearance of nodes (actors) 

NetDraw can also change nodes according to user needs. For example, if we want the 
actor with the highest degree of centrality to be indicated by the largest node size, 
under the Analysis menu, select Centrality Measures. The command will generate a 
dialogue box like the one shown in Figure 34. In the Set Node Sizes by: field, select 
Degree, and click OK. 
 
  

 

Figure 34. Node centrality measures dialogue box  

 

The analysis will generate node sizes according to the degree centrality values for 
each actor. In addition to being assigned the largest size, the central actor node can 
also be assigned a different colour to the other actors in the network. To do this, 
right-click on the Jana node, for example, click Color, select the desired colour, then 
click OK. The same can be done for the Petr_Ne node. Modifications to nodes based 
on degree centrality analyses will generate a network like the one in Figure 36. 

 

 

Figure 35. Menu for assigning colours to central actors 
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Figure 36. Sociogram based on a degree centrality analysis 
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